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Foreword 
The purpose of the Ternary Waste Envelope Assessment Tool Purpose of 
(TWEAT) is to graphically display the effects of glass composition on VN£AT 

glass properties. TWEAT is designed to display on a ternary or 
binary diagram a "region of acceptability" for processing user-
specified compositions of waste, frit, and (optionally) recycle subject 
to user-specified property limits. Single component crystallinity 
constraints can also be displayed on ternary and binary diagrams. 
TWEAT can generate property values for any selected point on 
either diagram. Tools are also available to display the boundaries of 
the experimental data over which the models have been developed. 

TWEAT can be used in the PNL Vitrification Technology Develop
ment Project to help decide if selected combinations of waste, frit and 
(optionally) recycle streams will produce a glass melt and final glass 
productthatmeetspecifiedprocessinganddurabiHtycriteria. TWEAT 
is currently a useful tool for glass design activities. With minor 
modifications, TWEAT can provide valuable input for Low Level 
Waste glassification efforts whether done by Hanford or through 
privatization. 

The largest effort in FY '95 was devoted to updating the models in Significant 
TWEAT to non-linear ones as found in the Composition Variability accomplishments 
Study (CVS)-II Phase 3 work"'. The solution/plotting algorithms 
were designed to be general so that second^order, temperature 
dependent, or other expressions yet to be developed could be 
displayed by TWEAT with minimal internal code revisions. These 
general plotting algorithms currently apply to the binary window 
only. 

The binary window and it's associated input/output screens were 
created to answer user criticisms that the only valid part of the 
Ternary diagram was the Waste/Frit axis. Addition of the Binary 
plotting capabilities provdes a tool which is now more useful to the 
glass formulation activities. 

Another focus of FY '95 development was the interface between the 
Macintosh based TWEAT and the Sun SparcStation based Optimal 
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Waste Loading (OWL) environment (developed using the General 
Algebraic Modeling System (GAMS) software published by Scien
tific Press). The interface allows electronic transfer of the results 
of an OWL calculation to TWEAT. The information transferred 
includes composition of the waste, frit and (optional) recycle streams 
as well as the constraints OWL used to reach its optimum point. 
Finally, the fractions of waste, frit (and recycle) determined by 
OWL are included.. All of this information is read into TWEAT and 
displayed on the appropriate diagram using the single TWEAT 
command'Import OIVLQata'. This new combination of OWL and 
TWEAT '95 is a powerful tool for formulating frits to combine with 
wastes and/or waste blends. 

The final activity for FY95 was preparing this letter report. 

These efforts satisfy the statement of work for this activity. 

lv TWEAT 
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1.0 Introduction 

The user assumes all risks in using this application. The 
code is not verified and not validated. Software control 
procedures have not yet been implemented. 

This report is designed to be a supplement to TWEAT '94 (PVTD-
C94-05.0 IK Rev. 1). It is intended to describe the primary features 
of the Ternary Waste Envelope Assessment Tool software package 
that have been added in.FY '95 and how to use them. It contains 
only minimal duplication of information found in TWEAT '94 even 
though all features of TWEAT '94 will still be available. Emphasis 
on this Update is the binary plotting capability and the OWL 
Import modifications. Like it's predecessors, this manual does not 
provide instructions for modifying the program code itself. 

The user of TWEAT '95 is expected to be familiar with the basic 
concepts and operation of the TWEAT software as discussed in 
TWEAT' 94. 

Software and hardware requirements have not changed since 
TWEAT '94. TWEAT has now been tested using Macintosh System 
software versions 6.05 through 7.5. 
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Purpose of TWEAX Update 

The purpose of TWEAT originally was to visually display the 
results of the PNL Vitrification Technology Development project's 
Property/Composition Relationships study . ( 1 ) These results consist 
of empirical models fitted to glass and melt property data as 
functions of glass composition. All properties are calculated as 
functions of mass fractions of nine specific oxides plus a general 
category of "other" oxides. 

Ternary diagrams were used to display how glass durability, melt 
viscosity, melt electrical conductivity, and selected liquidus tem
peratures depend on glass composition. Because of changes in 
project direction, a specific plant design no longer exists. Hence, the 
recycle stream is undefined now. Future plant designs will likely 
have a recycle stream, but for now we chose to add flexibility to 
TWEAT by generating a binary diagram when only frit and waste 
are being studied. The binary diagram in essence is a widened 
perpendicular (but inverted) look at the frit/waste axis. 

An example of a 
binary diagram 

Selected 'Proper
ties' appear with 
colored or shaded 
boxes. 

A "Constraint* line 
shows the limit for a 
particular •Prop
erty." The numeri
cal value represents 
a limit to stay above 
or below. 

Magnification: IX 

T»mp«r«ur»: 1350° 

Glass Properties Plot 
0 Vtaof̂ i (Pa*)**" 1000 
• VOT*J<P*X)1JO- 200 
0 EtoCM6Aid»* 10300 
D QnCendCS/teOU'* 1803 
• BFOVrrfZ* 820 
U BtxaaAttt* 2803 

• urtcfcfofls O F 
Qwcrcytezh wo Qraos 
OfeMCCtytiO QSCB 
• TiqCSt)Ml*Ota9D03 Qft tMK 
I Hq(C&TarcNm)aC»1COQJ00 
B Tt4&)°c*taao03 
QoaB 

NCAW 

1.0-

0.7-

0.3-P" 
0.4-
0.3-
0.2-
o.i-F" 
0.0-

Frit 

"E 
.n. 

a 
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Development and Application Status 

The development of the binary property window required (for ease 
of use and understanding) modifications to the Vertex Data Entry 
window and all of the output windows. The new versions are in 
addition to the old ones. All of TWEAT '94 capabilities will be 
retained. 

TWEAT is no longer limited to displaying only glass property 
models that are linear functions of glass composition. On the binary 
diagram any form of property model can be used so long as it is 
mathematically expressible in terms of the standard 10 oxide 
categories. Work has started on getting nonlinear models imple
mented on the ternary diagram. The technical (programming) 
complexities of using nonlinear models on a ternary diagram are 
nontrivial and could not be completed in FY 95. To avoid confusing 
the user (by showing nonlinear models on the binary plots and 
linear only on the ternary plot) display of the ternary plots is 
temporarily disabled in TWEAT '95. When the algorithms for 
plotting general order models on the ternary diagram are com
pleted, the user will be able to switch freely between binary and 
ternary modes. 

TWEAT '94 was shown to be a valuable companion to mathematical 
optimization algorithms which maximize waste loading by adjust
ing frit compositions to satisfy a specified set of glass property 
constraints. The Optimal Waste Loading (OWL) program is a 
customized application created at PNL to study various aspects of 
generating glass from Hanford wastes. TWEAT added value to the 
optimization results by displaying the "optimal waste loading" 
point on the ternary diagram. The exercises showed some optimal 
frits to be impractical because too many glass property constraints 
were approached simultaneously. In TWEAT '95 a new OWL 
import file was created to allow presentation of optimization 
results in either a 2-dimensional or a ternary diagram. Logic inside 
TWEAT determines which plot is appropriate based on OWL's 
output file. 

Ternary features are 
temporarily disabled 
in TWEAT'95. 
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2.0 What's New (and some review) 

Theory of Operation (binary mode) 
At its simplest, TWEAT takes a given glass composition and plots 
the value of at least one property constraint of that glass on a 
binary diagram. The compositions of the glass formers are supphed 
by the user and the property constraints to plot are selected from 
a list (actually the same list as for the ternary diagram). 

There are therefore at least two windows to navigate before a 
binary diagram can be generated; the user must specify the compo
sition of the waste and frit and also select at least one constraint. 

The program initially defaults to an NCAW waste stream, plus a 
compatible frit. This allows first-time users to quickly generate a 
binary diagram and explore the effects of changing constraints or 
stream compositions. 

The Vertex Data En
try window 

Specifies composi
tion of the waste and 
frit only 

Toolbar items func
tion analogous to 
TWEAT *94. 

NOTE: The Vertex 
Data Entry Window 
really determines 
whether TWEAT is in 
binary or ternary 
mode. Once the 
mode is set here, 
TWEAT automati
cally brings up the 
other appropriate 
windows. 



TWEATs Edit Menu 

Apply to any edit field 

Apply to the Vertex 
Data Entry window 

Toolbar buttons for 
edit field operations: 

Revert window to de
faults 

Revert vertex to de
faults 

Revert current field to 
defaults 

Can't Undo. &Z 

The Edit menu commands Revert Field to Defaults, Reuert 
Column to Defaults, and Reuert UJindoiu to Defaults per
form each of those actions respectively. These actions effectively 
restore the defaults just as they do in the ternary case. 

These same three com
mands are also available 
from the toolbar at the top 
of the Uertex Data En
try window (shown be
low). The gray shaded por
tion of each icon indicates 
the extent of the changes 
selecting it will make. 

Cut 
Copy 
Paste 
Clear 

\seiect an 

sec 

%R 

Reuert Field to Defaults 36F 
Reuert Column to Defaults 

.Reuert Window to Defaults 9SV 

Preferences... 

Tabbing away from the 
current field also illus
trates another point: 
TWEAT recalculates the 

column totals whenever you move from field to field. You can also 
force a recalculation by selecting Recalculate from the Tools 
menu, or selecting the recalculation button in the toolbar. 

itpr-rpH p»ta Fntry: Untitled 

The Tools menu has been modified to be a cascading menu. This 
clarifies for the user where the tools are applicable. Under the 
vertex data entry tool is a sub-menu of tools applicable to the Vertex 
Data Entry Window. The Calculate Other Oxides and 
Normalize Uertex Data tools are useful when the raw data 
being input do not exactly sum to 1.0000. 

The Calculate Other Oxides tool notes the current sum and then 
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Uerten Data Entry Uerten Data Entry 4 2 Recalculate 86K 
;J!S Normalize Uertex Data U1 Glass Properties Plot 

4 2 Recalculate 86K 
;J!S Normalize Uertex Data U1 

Update Glass Comp Chart Ox Calculate 'Other OHides' 86J 

Annotate Run Summary... t t n m 

- • 
t«QMt tiemoue necycie aire am 

adds or subtracts an appropriate amount to the "Other Oxides" 
field to make the sum 1.0000. 

The Normalize Uertex Data tool forces the total to 1.0000 by 
dividing each vertex entry by the sum that existed when the tool 
was invoked. Note that the tools act only on one vertex at a time 
and not the entire window. The same tools can be activated using 
the toolbar at the top of the Uertex Data Entry window. 
The Remove Recycle Stream is a toggle tool to switch between 
binary and ternary modes. 

Uertew Data Entry; Untitled 

Vertex Label: Vertex Label 

NCfllil 

Minor Components 
Renjcle 

Component 

^ 3 

P 2 ° 5 

NobMet* 

Vt. Frac. 
*s Oxide Component 

0.000967001 
10.009000001 

Cr 2 0 3 

P 2 ° 5 
10.007000001 SOj 

Io.0060000ol NobMet* 

Total: 

Vt. Frac. 
as Oxide 

Total: 0.025967 Total: jO.OttOQOOj 
Other Oxides Other Oxides 
from Vertex , , from Vertex, , 
DataVnd 10.2482000 | &»taVnd |g.'>»?1i:»» I 

*PdO, Rhj 0 ^' R u 2 ° 5 
Note also Vt. Frac. 
FasF-

The Minor Components 
tool will bring up another 
data entry screen which al
lows the user to enter minor 
components found in the 
waste stream. Note: in bi
nary mode only the waste 
stream is active; whereas, 
in ternary mode, both the 
waste and recycle streams 
can accept input. 

Recalculate tool 

Calculate "Other 
Oxides" amount 

Normalize all entries 
in the active column. 

Minor Components 
entry tool 
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Select Constraints 

The Constraint 
Selection item in 
the Windows 
menu 

Recall: Selecting the 
OK button in the Ver
tex Data Entry win
dow automatically 
brings up the Con
straint Selection 
window. 

Li.imdou.is H B ^ ^ B H I I H 
Uertex Data Entry X I 

,sConstraint Selection X 2 
Waste Stream Selection X 3 
Class Properties Plot X 4 
Glass Composition Range Plot xs 
Normalized Glass Composition Plot X6 
Minor Components X 7 
Critical Solubility Constraints X8 

OWL Property Comparison X 9 

Run Summary Report xb 

Once you have filled out the Vertex Data Entry window, the next 
step is to determine which constraints to plot on the binary diagram 
and determine their values. This is done by opening the Con
straint Selection window. This windowis identical for either the 
binary or ternary cases. Like all of TWEAT's windows, it can be 

activated by selecting it 
from the Windows 
menu, shown here. 

You select (or deselect) 
a particular constraint 
by clicking the mouse in 
the checkbox to the left 
of its name. An "x" in 
the box indicates that 
constraintis selected. At 
the moment, two tem
perature levels are 
available. Either 1150 

°C or 1350 °C can be used to calculate electrical conductivity or 
viscosity. (Depending on user feedback this may become a data 
input field so any temperature can be selected.) You can change the 

numerical value of 
any constraint byre-
typing the value, or 
by using the scroll 
bar. Two of thefield 
Editing tools, Re
store Field to De
faults and Restore 
Window to De
faults, are also ac
tive for the Con
straint Selection 
window. Restore 
Uerten to De
faults does not 
make sense in this 

Constraint Selection 
Sritct at y**si «w wartr»tot: | ^ m 

<8>1150* O1350* 
El Uiscosity (Pa*s):Hi 1 1 
12 Uiscosity (Pa*s):Lo 12 1 
3 Elec Cond(S/m):Hi hoo 1 
H Elec Cond(S/m):Lo Il8 1 

S B PCT(g/m-2) 182 1 
12 B MCC(g/m"2) 128 1 

12 Li PCT(g/nr2) U.8 1 
BLIMCC(g/m-2) •b. 1 
D Na PCT(g/nT2) |6.6 I 

Q Na MCC(g/m»2) ba 1 
12 Tliq (Spinel) *C 11050 I 

12 Tliq (ClinopyroHene) *C 11050 I 
BTIIq (Zr) »C 11050 I 

im 

it* 
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context so that Edit menu item will be disabled. 

Note that you must select at least one constraint - otherwise 
TWEAT has nothing to plot and you will not even be able to open 
the Glass Properties Plot window (which displays the binary 
diagram). 

Generation of the binary diagram is automatic when you open the 
Glass Properties Plot window assuming you started from the two-
stream vertex data entry window. You cause, this to happen by 
either selecting the Glass Properties Plot item from the Ulin-
doujs menu or pressing the OK buttonon the Constraint Selec
tion window. Note that neither option will be available if you have 
not selected at least one constraint. 

After selecting the OK button you should see a binary diagram that 
looks something like the one below. In binary mode TWEAT is 
really plotting properties as a function of waste fraction in 
the glass. Technically results are upside down from what 
one would get by viewing a ternary diagram along the 

% ffiass Properties Pfet '• 
Magnification: 1X 

T«mp*rature: 1350* 

• Vtaotfly 0>*»s)**« 10£B 
H Viscosity (Pa^ia- 200 
H OrcOxidCS/rrOHp 10003 
H SecGxdS/rrtUF 1300 . 
• BPCTCg/m"2>* 320 
• BMWgAfg* 28O0 
• LiPCTVm-^ 420 

• uMCOg/m'3 Qt 
iJIteFCVfrfS" 6JSO QP2D3 
Qtt>M3Xq/irC2) QSOS 
• -ractCSphtCC-IOSDOO QNetMet 
| TBq(Clricpyra>«f»)<>C=10SOOO 
• Tftj<a-)ec-iosooo 
• Cr203 

NCAW 
1.0-
0.9" 
0 . 3 - -
0.7-
0.6-
0.5-
0.4- j -
0 .S- -
0.2-1|2 
o.i-F^ 
0.0-

Frit 
•f^ 

\& 
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waste-frit axis . The lines crossing the diagram are the con
straints you selectedin the Constraint Selection window. The value 
of the constraint everywhere along the plotted line is equal to the 
input value you provided (or the defaults, if you did not change 
them). 

After the binary diagram has been created, you can easily move 
back to the UerteH Data Entry window or the Constraint 
Selection window to make changes. You can either click the 
mouse directly on your target window or make a selection from the 
Windows menu. 

If you make changes in any window outside the binary diagram, an 
alert flag will warn you that the existing binary diagram no longer 
reflects the most current input information. The diagram can be 
updated immediately by selecting the Update Nom button. You 
can get a last look at the previous binary diagram by selecting the 
UJait button. Whenever you want, you can update the diagram by 
selecting the Update Glass Properties Plot item in the Tools 
menu. 

At Tha enanoas you haua mad* in taa 
jSge\ iMrtaH or constraint data sra not yat 

AJsKjk raflactad in tna tarnary diagram. 

Whenever the binary diagram is the active window the Glass 
Propert iesPiot will show all of the supported constraints in the 
legend at the top of the window, but only those selected in the 
Constraint Selection window (or the Critical Solubility 
Constraints window ) will have colored or patterned boxes in 
front of them. 

The patterns are displayed when the current monitor is in black 
and white, otherwise TWEAT uses colors to distinguish between 
the selected constraints. The selected constraints will be followed 
by the numerical value of the constraint which was entered at the 
Constraint Selection window. 



The legend boxes at the top of the binary diagram function as toggle 
switches so any particular constraint can be turned on or off. This 
is functionally equivalent to selecting constraints in the Con
straint Selection window. Note that the numerical values for 

Glass Properties Plot 

Magnification: IX 
Ej Viscosay 0»«s) HS« 1003 
• VsBstty<Fa*5)L0B 200 
0 EtajCcndCSAn)**51000) 
1 ElecCcnfS/rtflcp. 1800 

DUMCCCg/m-21 QF 
E NaPCTCj/m*2>« 6£0 Q P205 
DNaMCC^An-2) DSQ3 
• TB?epi»tlc«>iaS0J00 D«**Mrt 

constraints cannot be changed directly from the Glass Proper
ties Plot window. For that you must return to the Constraint 
Selection window. 

Addit ional Tools 
Several tools exist to increase or refine the information on the 
binary diagram. They are completely analogous to the tools for the 
ternary diagram and are accessed the same way(s). 

The Shade Unacceptable Regions item in the Tools menu 
allows you to see which region of the binary diagram meets all of 
the constraint criteria. When you invoke the tool, each constraint 
is considered in sequence and the region of the binary which does 

M i l I I I KM 

1 | UerieH Data Entnj • 1 
Glass Properties Plat • <§, Enlarge 

€$, Reduce 
fS Grab 
f^j, Home Dieiv 

XE 
86 R 
SSG 
XH 

<§, Enlarge 
€$, Reduce 
fS Grab 
f^j, Home Dieiv 

XE 
86 R 
SSG 
XH 

Update Glass Comp Chart 

<§, Enlarge 
€$, Reduce 
fS Grab 
f^j, Home Dieiv 

XE 
86 R 
SSG 
XH Annotate Run Summary.-

<§, Enlarge 
€$, Reduce 
fS Grab 
f^j, Home Dieiv 

XE 
86 R 
SSG 
XH 

<§, Enlarge 
€$, Reduce 
fS Grab 
f^j, Home Dieiv 

XE 
86 R 
SSG 
XH 

f^Type ZUolues 
A Ouerfay EHperlmental limits 
S3 Shade Unacceptable Regions 
££ Point Value Tool 

XB 
XL 
XU-
XT 

f^Type ZUolues 
A Ouerfay EHperlmental limits 
S3 Shade Unacceptable Regions 
££ Point Value Tool 

XB 
XL 
XU-
XT 

Plot Composition Uncertainty... 
Plot Model Uncertainty... 

Update Class Properties Plot XO 

Shade Unaccept
able Regions tool 
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not meet that criterion is shaded. When all criteria have been 
considered, the unshaded white space in the diagram represents 
the acceptable region. 

The Shade Unacceptable Regions tool lets you quickly deter
mine which portion of the diagram meets all of the selected 
constraint criteria for the particular waste and frit you have 
chosen. In binary mode all constraints will show because shading 
is done after the constraint values to be plotted have been sorted. 
This is unlike the ternary shading algorithm where some proper
ties are covered because shading is simply done according to the 
order at the top of the Glass Properties Plot. 

The Shade Unacceptable Regions tool is a toggle tool. It will 
be checked in the menu if it is active, and cleared if it is inactive. You 
should be able to tell its state by visually inspecting the diagram. 
You can unshade the unacceptable region by invoking the tool 
again when the diagram is already shaded. The result is a display 
of only the constraint boundaries as in our original figure. 
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Calculating Properties at a Point 
The Point Ualue Tool allows you to select any point on the 
diagram (shaded or not) and generate a numerical value for each of 
the two vertices (i.e., waste and frit) plus values for all of the 
properties for which constraints have been selected. The numerical 
values appear in a floating palette that can be moved to any 
convenient location on the screen. Information stays on the 
floating palette until you click at another point or select another 
tool. 

a f i i n ^ 
1 yestex Satis t n t ru >• 1 

B3S33SSSIE33EIBB § . Enlarge 
Q I'm tines 

5 ^ Home (Haw 

Xt 

S6H 

Ujwiate $!**•? Ccmii Theft 

§ . Enlarge 
Q I'm tines 

5 ^ Home (Haw 

Xt 

S6H Annotate Run Summary— 

§ . Enlarge 
Q I'm tines 

5 ^ Home (Haw 

Xt 

S6H 

§ . Enlarge 
Q I'm tines 

5 ^ Home (Haw 

Xt 

S6H 

S h g p e Z names 
A Overlay Experimental Limits 
9 Shade Unacceptable Regions 
4 £ point Value Tool 

S6B 

XL 

xu 
XT 

?!C4 ;"»!nae$iti&n Sneer; s in ig. . . 
?!6t MOliei I i i)(ai1ft! l i t! j... 

- Update Class Properties Plot SO 

Point Value tool 

The Point Value tool 
inaction. Note the dot 
on the diagram. The 
information displayed 
on the floating palette 
describes the glass 
for that point. 

The floating palette 
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The Glass Properties 
Plot window with the 
Shade Unacceptable 
Regions Tool active. 

The experiments 
boundary limit rect
angle 

Note that the values for waste and frit in the upper left-hand corner 
of the Glass Properties Plot window follow the mouse in real time. 
They will change as soon as you move the mouse again after you 
select a point. Once you do select a point, waste and frit fractions 
as well as the constraint values and glass composition are dis
played on the floating palette. TWEAT also deposits a small black 
dot at the point on the diagram where you clicked the mouse. The 
point and the values displayed on the palette remain "frozen" until 
you select another point. 

Composition Boundaries 
All of the glass property models have been developed from experi
mental data. The experimental envelope continues to expand. 
Since it is experimentally impractical (and unnecessary) to test all 
components from 0 to 1 mass fraction, the models are valid only 
over a restricted composition space. With linear models it is easy, 
but generally not advisable, to extrapolate beyond experimentally 
tested compositions. TWEAT thus provides the user withfeedback 
on where the property models are valid. This can be done with the 
Ouerlay Experimental Boundaries tool from the Tools menu. 
The composition boundaries are shown with thick blacklines on the 
binary diagram, as illustrated below: 

Class Properties Plot 
Magnification: 1X 

T«np«r»tuP»: 1130* 

|Vtawly<P»»*)HN10a> 

| fi BtoCordSMHf 10003 

laccorfS/WtD" laoo 

iQBPCKg/rrTZ)' 830 

| UPCTCfl/WiT2> 4 J 9 0 

HN»PCKg/m"&' ieO QP33S 
• N»MCDC$/W2) QSS 
1 •TlqCSpi»t>or>1030JD QltttMtt 
| TS?(C&xpLin»fl«n»)cC"1COOjCD 
| TSn<a-)°O1030a0 
• Q-203 

NCAW 

o.o 
F r i t 

mMmmmmm î ns; m 
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When a point has been selected on the Glass Properties Plot, a 
Glass Composition plot can provide useful information in terms 
of where we are within our experimental database. In binary mode, 
the thin horizontal line identifies the point of the mouse click (or the 
OWL import point). Wherever the line crosses a composition bar, 
the point is outside our experimental limits for that oxide. White 
space is within the limits. 

Glass Composition 

Elemental Glass Compositions Normalized to Waste Loading 

F*20S A1203 others 

The Glass Composition Range Plot window is only available 
when you have selected a data point, and it is valid only for that one 
point. This plot for the binary system is different from the one for 
the ternary system. The binary version normalizes all limits to 
some fraction of the waste stream. Presenting data this way is 
useful for guiding the OWL runs because it shows which limit will 
hit next. Users and readers are cautioned that you can NOT 
assume bars in the upper part of the window represent upper 
limits. Which limit is which (upper or lower) depends on the ratio 
of a particular component in the frit to that in the waste. Numerical 
values in the floating palette are backup indicators as to which 
limits are actually being approached. If you would like to know 
which experimental limit is represented by any portion of the 
experimental limit rectangle, simply select a data point just barely 

[Plans are to include 
numerical values for 
the ends of all bars. 
That feature was not 
completed intime for 
this report.] 

The line (Data Point) 
represents the waste 
loading shown onthe 
floating palette. Plot 
shows we are outside 
experimental limits 
for Si02 and Na20 
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beyond the limit line in question. The floating palette highlights 
and flags the glass component whose limit was broached. 

Silica and sodium are 
beyond limits for the 
point chosen (i.e. 
NCAW » .1897 and 
Frit= .8103) 

:QSHK2?HSHHH£KHH^£Hn:£5H:n:H:H:H::; -IHirr-HliinHlHH::! 

NCAV: 0 . 1 8 9 7 •HH 
F r i t : 0 . 8 1 0 3 iKBi 
— Const ra in t Values & Pt — 

Viscosity (Paos): • 11.18 
E1»cCond(S/m): * 19.48 
BPCTCq/m*2) » 1.46 
UPCT(q/m-2) - 1.47 
Na PCTCq/m*2) • 0.73 
TMa CSpitwO «C » 917.0 
Tliq (Clinopuroxen*) °C » 833.5 
Tliq (2r) *C « 878.3 

— Glass Composition — 
Si02 » 0.596o<>*xp l imit 
B203 = 0.159 
Na20 = 0.040«<>oxp l imit 
Li20» 0.055 
Ca0» 0.001 
MgO» 0.000 
F«203 • 0.053 
A1203 = 0.017 
2 r02» 0.028 
others" 0.047 

As a final note, be aware that some of the glass components are 
frequently present in such small quantities that they do not create 
a visible bar on the small chart. 
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3.0 Menu Reference 

Most menus in TWEAT '95 have changed either in looks or in order 
of operations or in shortcut keys used for various selections. The 
lone exception is the Edit menu which remains the same. The 
changes were made to group operations in a more logical sequence 
for the user. 

The Apple Menu 

flbout TUIEflT... 
TUIEBT95 He lp 

The File Menu 

Displays the TWEAT splash screen 
(aka the credits, or the bird* screen). 

- Opens and activates TWEATs on-line 
help system. 
Closes all open windows and resets. 
TWEAT to its default state. 

Opens a data file previously saved from 
TWEAT. 

Closes the topmost window. 
Saves the contents of theUerteH Data 
Entry window, Constraint Selec
tion window, Minor Components 
window, and Critical Solubility 
Constraint window to disk. 

Saves the current data file under a 
different name. 

Saves the topmost Window as a PICT 
image file. 

Imports data from the Optimal Waste 
Loading environment (OWL). 

Imports tab delimited data fortheUer-
tex Data Entry windowfromspread
sheets, database, etc. 
Activates the page setup dialog for the 
current printer. 

Prints the topmost window. 

Closes all windows and exits the 
application. 
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The Edit Menu 

Can't Undo... §§Z 

Cut 
Copy 
Paste 
Clear — 
Select Rll 

Reuert Field to Defaults 3tF 
Reuert Column to Defaults 
Reuert UJindoui to Defaults §€V 

\ 

Preferences... 

The Windows Menu 

If an undoable action has just 
occurred (e.g., a Cut operation 
in an editfieid)thisitemchanges 
to Undo. It wilt reverse the ef
fects of the last operation. 
Oeietes currently selected text 
but keeps a temporary copy of it 
on the clipboard. 
Copies current text selection to 
the clipboard. 
Pastes the clipboard text into 
the current edit field starting 
where the cursor is located. 
Oeietes current text selection 
without copying it to the clip
board. 

Selects all of the text in the 
current edit field. 
Reverts contents of current field 
to its original default value. 
Reverts contents of all edit fields 
in the current column to de
faults (applies totlertex Data 
Entry window only). 
Reverts all edit fields in the cur
rent window to defaults (Uer-
tex Qata En try and the Con
straint Selection windows 
only). 

Not implemented in TWEAT 
'94 or TWEAT'95. 

Each menu item opens the 
window of a similar name. 
See the Window Reference 
(next chapter) for a descrip
tion of each window. Notice 
the short-cut keys have 
changed from TWEAT '94. 

For ternary case only 

For binary case only 

Windows 
UerteH Data Entry 
Constraint Selection 
Waste Stream Selection 
6lass Properties Plot 
Glass Composi t ion Range Plot 

/ Normal ized Class Composi t ion Plot 
Minor Components 
Cr i t ical Solubi l i ty Const ra in ts 

QUJL Proper ty Comparison 

961 
362 
963 
964 
%5 
m6 
&7 

S89 

Run Summary Report mn 
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The Tools Menu 
Tools 
UerteH Data Entry • 
Glass Properties Plot • 

Update Glass Comp Chart 

Annotate Run Summarg... 

Tools 
UerteH Data Entn 
fiilasA Properties Plot • 

Update Glass Cornp Chart 

Rnnotate Run Summary... 

X Recalculate 9§K 
"MM Normalize UerteH Data 8§l 
Ox Calculate'Other Oxides' SgJ 

/ 

tflnwe fagtie Remove Recycle Stream 
\ 

TheToolSmenuhas 
been modified for 
clarity. BbththeUer-
te« Data Entry 
window and the 
Glass Properties 
Plot have a cas
cading sub-menu. 

Sums compositions 
in a vertex in ifer-
te« Data Entry 
window. 
Adjusts all fields in a 
vertex such that 
sums equal 1.0000. 

Adjusts 'Other 
Oxides' such that 
vertex sums to 
1.0000. 

Toggles between bi
nary and ternary 
mode. 
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Increases the magni
fication of the Glass 
Properties Plot. 
Decreases the mag
nification of the Glass 
Properties Plot. 

'Grabs* and scrolls 
the Glass Proper
ties Plot.. 
Returns Glass 
Properties Plot to 
100% and centered. 

Enlarge 

•€^ Reduce 

Annotate Run $umrrrtfq^..[ _ J B n o m e m e u j 

'Allows manual entry of vertex 
values on either binary or ter
nary diagrams. 

. Displays limits of experimental 
data on 6lass Properties 
Plot.. 
Toggles shading of unaccept
able region on Glass Proper
ties Plot.. 
Toggles pointplotting on Glass 
Properties Plot with mouse. 
Displays composition uncer
tainty on Glass Properties 
Plot (not implemented in 
TWEAT -95). 

Displays model uncertainty on 
Glass Properties Plot., (not 
implemented in TWEAT '95) 

Forces recalculation and draw
ing of Glass Properties Plot. 

XE 

/ ( s s j T y p e Z Values KB 

A Ouerfay EHperimental L imits XL 

' / j & ! Shade Unacceptable Regions XU 

4 £ Point Ualue Tool X T 

Mot Composition Uncertainty. . . 
Mot Model Uncertainty. . . 

'Update Glass Propert ies Plot X 0 

The Help Menu (System 7.x Only) 

Displays description of balloon. 
help (provided by operating sys
tem). 

Turns on Balloon Help (provided 
by operating system). 

Turns on TWEAT Help System -
(provided by TWEAT). 

About Balloon Help.. 

Show Balloons 

TLUEflT'95 Help.. 
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4.0 Window Reference 

The "About" Window, aka Credits Screen 

The About window is simply 
the title screen. It also credits 
the organizations responsible 
for TWEAT, namely Pacific 
Northwest Laboratory and 
Ariel Publishing, Inc. 

Tool 

For Its O H Emtape 
DefintfooSmdytfciePNI. 
Vitrification Teefloolofjr 
DcvriuuujMUFioJMi 

The Vertex Data Entry Window 
The UerteK Data Entry window allows users to input source 
stream compositions. Data can be entered by hand, imported from 
OWL, cut and pasted from most spreadsheets, orimportedfromtab 
delimited text files. 

Save data file to disk 
Show Page Setup dialog 

Print this window, 

iestore current 
field to default 

edit 

Restore entire vertex to defaults 
iestore entire window to defaulfs 

Recalculate column totals 
Recalculate ' O t h e r O x i d e s ' 

Normalize vertex data 

Vfrt«cUb»l:fl Vtrtex L*b«l:lNCAV V t r t t x U M 

Component Vt.Frae. I 
tfOxid* 1 

SiO, 10.7356 1 

B2Q5 I0.I9M 1 
NsjO 10.0000 1 

U2O |0,Q681 | 
CeO 10.0000 1 
MgO 10.0000 1 
F «2°3 10.0000 1 
A'20s |0,TOTO 1 
ZrOj 10.0000 1 
Other I0.0000 1 

Oxides 
T»m \XXS30 

Component 

Total 

Vt.Fr*e. G 

'°-°o«P 
I2J2Q2L 
I0-2M2 

looooo 

100904 I 

Q.T?11 I 

1.0000 

Component 

Total 

Vt.Fr*c. 
<*0xMt 
to.4567 I 

ipjasaL 
l°«2S3 ' 

00032 I 

'00000 J 
'00601 ' 

1.0000 

It 

O 

Open Excel Datafile 
Open Minor Components 
window 

'Revert to binary mode i.e. no 
recycle stream 
vAccept window contents 
and open C o n s t r a i n t S e 
l e c t i o n window 

file:///XXS30


Binary Vertex Data Entry window 

Toolbar functions are 
the same as for the 
ternary Uertex Data 
Entry window 

H i 

Revert badctoternary 
Uertex Data En- ' 
try window. 

UerteH Data Entry; Untitled 

Vertex U M : Vertex Ubel: NCAV 

Component Vt.Frae. I 
asOxMe I 

SiOj l°,735$ 1 

B2O5 10.1963 1 

N»2>0 10.0000 1 

U2O lQ,o«1 1 
CsO ICLOOOQ.. 1 
MgO 10.0000 1 
F «2°5 10.0000 1 
A12Q3 10.0000 1 

2r02 10.0800 1 
Other 10.0000 1 

Oxides 
0.4567 1.0000 o 

Component Vt.Frjc. I 
jsOxMe I 

SiOj 10.0040 

B2O3 10.0001 1 

N»20 10.2142 I 

U-J) 10.0000 I 

CaO |o,W7? 
MgO ISLPJ229 
Fez 0* |Q2?21 I 
«203 l0.0904^ I 
2r02 10,1511 1 
Other 

Oxides 
J0.2482 1 

0.42S3 t.0000 

•tr 
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Constraint Selection Window 
The Constraint Selection window allows the user to select 
which property constraints to plot in the 61 a s s Proper t i e s 
Plot window (i.e., either the binary or the ternary diagram). 

Restore current edit field to defaults 

Constraint Selection 

|S*l»et»t ltwt am constraint: fug 

H Viscosity <PoV$):Hi 
12 Viscosity (Pa*s):Lo 
H Eiec Cond(S/m):W 
g| Elec Cond(S/m):Lo 

0 B PCT(g/m-2) 
SBMCC(g/mA2) 
S Li PCT(y/m*2) 
S LI MCC(g/m~2) 
D No PCflg/m-Z) 
D No MCC(g/m-2) 
EITJiq (Spinel) »C 
S Tllq (CllnopyroHene) *C 
BITIIqCZrJ'C . 

Restore entire column to defaults 
Open the Critical Solubility 
Constraint window 

Accept the contents of this 
window and open the Glass 
Properties Plot 

Temperatures apply only to 
viscosity and electrical con
ductivity models 

Type in edit fields to change 
numerical values forany con
straint 

Glass Properties Plot 

•tafriflutha: IX 
1 Slaw Propartle* Hat I EM 

QuwMKa ]i*are 

The Glass Properties Plot displays either the binary or the 
ternary diagram showing the constraint lines selected in the 
Constraint Se-
l ec t ion window. 
The Tools menu 
has many options 
that change what is 
displayed in this 
window. Note that 
the value of each 
constraint and the 
identifying pattern 
or color are dis
played at the top of 
the window. 

Frit 

•CAW Raegela 

s: J££J 
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The binary Glass Properties Plot uses the same identifying 
color/pattern for each property as does the ternary version. 

Class Properties Plot 

M49Ruic4tion! >** 

Twiipwatir*:. 1 ISO* 

E3 Vta**D<P»«s)H» UUB 
IVtart t lpH^las 203 
Q BmCattSMm tOQCO 
M BtaQxdSMH** 180J 
0 BPCTGj/irf'Z* 82) 
g BMKijAiif2> 2B0J 

ONiPCIC»A«r»&ffl DP3B5 
DN»Mas»A»fa Qsas 
• T5a^nrtsC»1Q50£D QftthW 

QoatB 

o 

NCAW 
UJ 
0.9 
0.8 
0.7 
0.6 
ea+-
0 .4 - -
0.3 + -
0 2 
0.! 
Oil 

Frit 

3T 
6> 

15 

Glass Composition Range Plot 
Glass Compasil ion 

The Glass Compo
sition Range Plot 
displays a color or 
pattern encoded bar 
for each glass com
ponent at a selected 
point on the ternary 
diagram. If the com-
position is well 
within experimen
tal limits, the bar is 

encoded green. If it is close to a limit, it is encoded yellow, and if it 
is beyond the limit, it is encoded red. 



The binary version of this plot is quite different. Here all results are 
normalized to waste loading! This visualization makes it easier for 
OWL users to spot which limit is likely to hit next (i.e. limit waste 
loading.) The final version of TWEAT '95 will identify upper and 
lower bounds numerically. 

Glass Composition. 

Elemental Glass Composftions Normalized to Waste Loading 

Si02 8203 N«20 1120 C*0 MoO F»203 A1203 Zr02 ottwrs 

• C A V : 0 .1943 
F r t t : O.T2S* Warn « M « a l > : 0 .1215 
— C i M l r t l r t W M t f l -

Vtot«>l 190*0 0 » * t ) : • *X2 
ClnCaMOM*): • 29.77 
• -CTU/aV2> • . 2M 
•nccfe/urs • X24V* 
U M t t U / m l ) • 20.4* 
K.MXU/m-33 • » l * 4 
I * S ( « H » 0 * C • ( K M 

K > 0.1421 
K>20< 0.004* 
I S O * 0 » » 
CaO- 0.001* 
H | 0 « 00007 
F»2U> 0J044« 
AB0>« 0 3 1 * 0 
& < » • OJ02M 

The Floating Data Palette 
The Floating Data Palette is only open when you 
are plotting points on the Glass Properties 
Plot with the mouse. It displays the values of 
the selected constraints at the point as well as 
the composition of the glass. 

The Floating Critical Solubility 
Constraint Palette 

This data palette is open only when you have 
selected critical solubility constraints and have 
selected the Crit button in the upper right hand 
corner of the main Floating Data Palette shown 
above. The Critical Solubility Constraint Pal
ette shows the values of the selected critical com
ponent compositions at the current data point. 

Cwwtraiat V . t a . — 
CrtOS 0.0011 
r 0.0004 
P205 00056 
SOI 0.0026 

" * " QJ0O22 

K you have selected 
critical solubility con
straints, selecting this 
button will open an
other palette that dis
plays their values at 
the selected point. 
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S O S S 5 S S 2 Type Z Ualues: ^SSSSSS 

zs;Ncau» 

Z2s W t 
Z3: Recycle 

EEjHiSMI zs;Ncau» 

Z2s W t 
Z3: Recycle 

0.0000 
zs;Ncau» 

Z2s W t 
Z3: Recycle 0.0000 

zs;Ncau» 

Z2s W t 
Z3: Recycle 

••III I ^ ^ H M 
( Cancel 1 1 Update Now V ( Cancel 

The Type Z Values Window 
The Type Z Ualues window al
lows users to specify exact Z coordi
nates for a data point on the Glass 
Properties Plot. (Only Zl andZ2 
show for the binary case.) The 
Update Now buttonplots the point 
and recalculates the appropriate 
diagram. 

Minor Components Window 
The Minor Components win
dow is where the user can 
specify minor component com
positions of a given waste or 
recycle stream. These-composi
tions must sum to a number <= 
the Other Oxides for the waste 
and recycle verticesin the Uer-
tex Data Entry window. 

This window is only available 
in the UJindoivs menu when 
the Uertex Data Entry win
dow is the active window. For 
the binary case, only the Waste 
stream is active. 

NOW 

Minor Components 

Recycle 

Component VtFrae. I 
asOxidt 1 

* 2 ° 3 liLSSBSSSOS! 
F [gjBSB&soJ 
P 2°3 lOOOTOOOOOl 

SO, lO.OOTOOOOOl SO, 

Nobftet* 

Total: 
Otter OxMos 

l0.006O00O0l 

0.023967 

OatoVnd 102482000 I 

Component 

<v» 
P 2 ° 5 

*>3 

Vt.Frac. 
«t(briO> 
I0.000t6700l 

lo.OITOOOOol 

Ior0006613o1 

loCTowy?! 

Total: 

Ottwr QxMtff 
0X17932 

OataVM IOJ801000 I 
*P«3t RhjOjj RujO. 
Not»«h»VtFras. 
F«*F- 15558 Egj&ad 

Critical Solubility Constraint Selection 
= D S B Crit. Sol. Constraints 

Soioet constraints to display: 

HCr203 lOJMSO I 

10.0170 1 

SP205 
EJS03 
S NobMet 

10.0100 1 

10.0050 1 

10.0230 ! 

•PdO,Rh203,Ru205 gag 
Not*: Voight Fraction F i »F- m' i i i i i m m 
All others as oxidM 

»F-
PQBQCBfS 

The Critical Solubility Con
straints window exists to al
low users to select which criti
cal solubility constraints to plot 
on the Glass Properties Plot 
and at what limiting value. 

This window is only available 
in the Windows menu when 
the Constraint Selection 
window is the active window. 
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The Run Summary Report 
Although primarily 
designed as a per
manent, hard copy 
recordofaTWEAT 
session, the Run 
Summary report 
is nevertheless 
placed into a scroll
ing, resizable win-
dowforpreviewing. 

The Run Sum
mary report does not require any user interaction. Instead, it 
displays the current data sets in tabular format and also repro
duces the Glass Properties Plot and the Glass Composition 
Range Plot in miniature. TWEATknowswhetherthereportisfor 
a binary or ternary run. 

The On-line Help System 

tiammmsmmmMmmmn TUIEBT Run summary immmrnsmmsmmMm 
TWEAT Run Summary 'I 
tut.: 0 8 / 0 2 / 9 4 7:44:33 PM 

Weight Fraction Oxides 
mu» tna KUWMIUB. C»I 
R H t M l M*JWVVt*ln>*J *M 

Component Frit NCAV Rtcyclo Glon Outftt* 
Ci».BmOa 

Site 0.735* OJXHO 0.41*7 0.4471 Na 

fafa O. I1U 0O001 0J9Q00 0J99H Hi 

W26 OJ3000 02142 0.433J 0 . I 4 I I N> 

U20 OjMOt OJOOOO OJOOOO 0J3J4I No 

CoO O4O0O OJ0C79 ojoon OJJOJJl No 

MgO OJOOOO O J O O S O 0J3OS2 0X012 No 

taoi OJQOQO 0.2S2I OJ0IO7 OOW1 No ] ] 
Man OJDOOO OJM04 0JJ410 OJHM "* 1 
2rfc 0.0000 0.1SII OJOOQO OJJ*t» 

'„„ * t 
«lSfT» IHml.W-illlll. MilliiilJIIIIiil milliil.MIHMM tJlilblllllibill! !iil:;illl!lll!!!ll IHIHIilwrj 

TWEAT's on-line 
help system allows 
you to select a help 
topic in the scroll
ing list on the left, 
and then read a 
brief description of 
the topic in the in
formation area on 
the right. 

TIUEIM 94 Help 
Help Topics 
ConotrtlMSOIOCttM : * 
CrtUcol SoloMUtvCoootmato 
DatoFOoo 
Onto Motto 
Gonorol Ovorvtov 
Grabbor Tool 
Hints oadTtw 
Minor CompomnUi 
Printing 
BunSvMBory Bnport 
STKAMIgoto 
Tool bore: Coral mint Moctton 
Toolbar*: Vortox Doto Entry 

Toola: Coaioootttoa Unoormnto, 
TooU:iOltlogTool» 

3C Select 

Bade I I « 1 I » I I Firtt I [ Last 

• Canttralntt Satactlon • 
Too aort of tto Control *ta oolocttoa vtadov oaova 
oolov provMoo « M wlUi o« opoortoaltu to ooNct oao 
or norooMotroiMooRgoOlt Motr vol on. Not oat* oon 
yonoolt from too koytoora, out yon o»v 0)00 on* too 
oerollbor to ooroll or poon throiaja. too roooo of 
oooolMovoltioo. 

•troll tor toco***) or 
ovorrMa too vol00 anowo 
lataooottflOM. 

B Vise #115S*C (PaosfcHI |JS 
B llisc e>l 1 S0*C (Pa*t)Oa 5 " 
OEMcComKS/nildn fita 

Run Summary Annotation Window 
Run Summary Window 
annotation: 

My f l r t t Run Summary 

1 Cancel ] | OK 

This window allows users to place custom 
text on the Run Summary report. This is 
often useful to highlight details, point out 
problems, etc. 

Window Reference 4-7 



The Estimated Model Variances Window 
This feature is tem
porarily disabled in 
TWEAT *9S. The 
pianistorecodethe 
calculations afterthe 
general order plot
ting routines on the 
ternary diagram 
have been com-
pleted. 

Estimated 
Node! 

Variances 
F Statistic ftaltlplter: 
S M TVEAT USW'S M W I M I 
far discussion. 

4.1 

^Shouj Error 3 
(if: ;;yjCancelSgji#] 

This window appears when you select Plot 
Model Error from the Tools menu. It 
requests the F Statistic Multiplier, a sta
tistical multiplier based on the number of 
coefficients used in the model and the 
number of observations used to determine 
the coefficients. Most users will simply 
want to accept the default value shown in 
the window. For TWEAT *94 and '95, the 
value is 4.1. • The F Statistic Multiplier 
will change to a vector of values in future 
versions of TWEAT. 

Recall a "normal" win
dow here would show 
identical numbers in 
theOWLandTWEAT 
columns. 

OWL Property Comparison Window 
This window is only available 
when you have imported 
OWL data. It allows you to 
compare OWL's values for the 
selected constraints at the 
solutionpoint with those com-
putedbyTWEATforthe same 
point. For the binary case 
Recycle is omitted. It's sole 
purpose is to spot discrepan
cies between the TWEAT and 
OWL property models. 

iEJ l OUIL Property Comparison 
j— V«rtwt Fraatte* 

r f r f t _ ~: 

.^EWctCond'k, 

i1SS82!2r*jf*& ,^5^0928-&^&f%4^Z2~i~*« 

e^safeSafiyfeBtesffl* 
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Appendix A: Property Models 

Property Model Formulations 
The table on page A-4 shows the mixture model coefficients used 
to predict various glass properties. The coefficients are based on 
CVS data up through CVS-II Phase 3 data(Hrma etal. 1994). The 
linear mixture models express some transform of the property as 
a function of mass fraction of nine specific oxides plus a general 
category of "other oxides." These fitted property models are quite 
preliminary, and have statistically significant lack-of-fits in some 
cases as discussed in reference 1. 

The linear equations (applicable to the 3 liquidus temperatures) 
are of the form: 

1=1 

Where: P.* is the transform of property P. 

C~ is the coefficient of the i f t component for the j t t property 

gi is the weight fraction of component i in the glass mixture 

The calculation of g. is as follows: 

g, ={f, * F+ w, * W+ r t * R) /(W + F+ R) 

Where: f. » weight fraction of component i in the frit 
F s weight fraction of frit in the glass mixture 
Wj = weight fraction of component i in the waste stream 
W = weight fraction of waste in the glass mixture 
r. = weight fraction of component i in the recycle stream 
R = weight fraction of recycle stream in the glass mixture 

By convention, W + F + R must sum to 1.0000 



The equation for electrical conductivity is the Arrhenius equation 
in the form: 

i»l 

where T is in degrees Kelvin 
A and B5 are coefficients 

The Fulcher model for viscosity is: 

10 
I T T ^ X AiSi + 

i-1 

10 

i - l 
10 

T-lTigj 
i»l 

where A., B,, and T. are constants 
T is in degrees Celsius 

The release rate equations (both Product Consistency Test [PCT] 
and Materials Characterization Center [MCC]) are cast in Scheffe' 
second order models in the form : 

10 9 10 

R* • X ai & + Z X b« Si gj 
i«l j«l j«i+l 

where at is the coefficient corresponding to the 
first order term in ĝ  

b~ is the second order term involving g, and gj 
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The property inverse transforms are: 

TH q «liquidus temperature (°C) 

T„ = T*Kq for spinel, clinopyroxene, and 
Zr-containing crystals. 

r\T = viscosity (Pa»s) atT°C 

TIT s exp(7i*T) 

&j. = electrical conductivity ( S/m) at T °K 

£,, > exp(e*T) 

R, = release rate (gm/m2-28day for MCC and 
gm/m2-7day for PCT) 

R « exp(R\) 



Coefficients for Property Models 

~ — " „.,', " rr~.v~r_-̂  •-• ' • 1 r—•• 

SI02 B203 KW20 1120 DO M30 FE2Q3 AL203 ZRQ2 01r€HS 
At A2 A3 A4 AS A6 A? A8 AB A10 

vec • 10.5899 -24.412? 2.0200 S.4S5B 3.9535 5.3088 -13.6326 1,4998 -0.3590 -2.3815 
Fulcher B1 62 B3 B4 B5 86 B7 88 89 810 
Tln-C 19236.3263 15922.8410 .12965.4177 •39177.2042 • 18671.4525 • 11943.6611 14659.3344 8524.4368 4.618.1457 1710.2061 

T1 T2 T3 T4 T5 T6 T7 T8 T9 T10 
76.112? 263.4849 425.7163 474.4299 1065.6248 752,2421 " 43.6384 178.5252 540.5086 270.7406 

A1 A2 A3 A4 A5 A6 A7 A8 A9 A10 
ELEGCCND B.112232 12.B16943 6.054906 7.473173 14.40877 10.39029 9,940459 7.138001 7.93431 18.114167 
Afhennlu* B1 B2 83 84 B5 06 B7 88 89 810 
Tln lC - 1 0 2 8 3 • 16135 7089.4755B 22464 •18768 -13414 . 1 0 6 0 8 -8227.1802 •9723.860? -20653 

at a? a3 #4, «5 B6 •7 *B 9? atO 
PCTB -4.379969 •3,080004 21.440506 24.173983 14.06971 •49.728B1B -1,311381 -39.578233 -11.416302 4.206259 
2nd order b8:B=AL AL b2.2=B B b1:6«SIMQ b3;5»NA, CA t>2:5=B .CA b6:9=MG 28 

104.2182S4 76.658177 117.171887 • 120.88413 •91.140649 122.085204 

al a2 •3 «4 a5 a6 •7 a8 •9 alO 
PCTU •2.951747 •S.82881 18,742066 18.904144 14.066675 14.47951 .5 .631035 •31.38079? •10.211191 2.852327 
2nd order bB:8=Al AL b2:2«B B b6:B«MG AL b2:6=B CA b3:5=NA CA b3:6=NA Al b7:8»FE AL 

94.02520B 76.945946 • 194.707636 •94.6921 •81.928019 •43.351121 75.966423 

al 4? •9 a4 •5 #8 •7 a8 a9 a 10 
PCJNA •2.S7681 -10,646234 15.284061 4.552893 7.532897 •30.228288 -1.307042 -34.646706 -9.218464 2.496056 
2nd order bf.6*S{ M« b2:5=B CA M:4.NA M b2.?-8 B 64:«*U MQ b«:8«At,,Al 

75.062121 •77 T 102749 126.135743 98.286041 133.332409 81.817476 

al »2 a3 »4 »5 a8 a7 •8 »9 alO 
MCC.B •1.566678 15.884339 11.442222 13.358676 •39.786566 43.631246 6,32350 -8.841645 •1.2859? S.4S9863 
2nd order b8:BcAL,AL b2:B»B At b1:5*SI CA b5:5=CACA b3:6=NA MQ 

69.05324 •80.041445 70.192224 111.801884 •$8,424388 

UQSPWEC C1 C2 C3 C4 CS C6 C7 Cfi C9 • cio 
linear 969.305474 666.419006 9.772076 • 128.772539 1366.211045 2830.582448 2256.0012 1735.02572 826.109425 1005.55533 

UQ2RC C1 C2 C3 C4 C5 C6 C7 C8 C9 CIO 
linear 753.776337 1095.83041 74.313813 •958.393494 886,76338 2458.467726 1461.03907 1138.06107 4541.99413 657.994105 

LKXLNO C1 C2 C3 C4 C5 06 C7 C8 C9 C10 
linear 955.648708 314.718016 38.628095 •207.052312 1372.437773 2387.619243 1606.68726 1318.78139 1844.50102 1357.4044S 



The correspondence between data in the table and the model 
equations is fairly obvious. The order of glass components is always 
the same. Thus Aj or a t always referto Si0 2 and Ag or b 5 always refer 
to CaO. The coefficients are the same in the model equations as in 
the table with the exception of the Scheffe' second order models. 
The nomenclature in the table is an attempt to clarify which oxides 
are being used. Thus b l:6=Si_MG for PCT B release model means 
coefficient b (117.171887) is to be multiplied by the product of the 
1"* and 6 t h oxides which are Si0 2 and MgO respectively., The b 
coefficients which are not defined are simply 0.0. 

Property Models A-5 
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